CPDev - LD programming
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Introduction

CPDev environment supports programming in graphic LD language (Ladder Diagram) by means of
LDEditor module (external component). Users can create programs and trace values of variables
during simulation. In this instruction creating a typical program in LD language involving contacts,
coils and function blocks is described in details. Other examples are also provided, such as com-
mon switching circuits, sequences and simple processing of other variables than BOOL. It is as-
sumed that the user is familiar with basics of using CPDev environment.

START-STOP diagram

Diagram elements

» Final program in LD language is shown below. It contains:
- contacts START, MOTOR
- negated contacts STOP, ALARM
- coils MOTOR, PUMP
- instances DELAY_ON, DELAY_OFF of function blocks TON, TOF
— constants T#5s, T#10s

- comments.
- {STARTSTOP | - - -
'3STAR'T'@:-:-'ST'OP'-?ALAR'M:-:-:-:?3-MDT'C\I}'R'-:
A o T o s v sk etk g
||,*,,|/},../1|.,,,_..\j..
:::I‘-JC'-FO.F{.:. G B ga Lok pa Bl BRUE oS gR o Wk ol b MR
11
____f_'f___DELAY_DN DELAY_OFF
- MOTOR - - - - TON TOF - PUMP - -
IN Q N Q {\'
BT PT ET

- | The program turns on /offa MOTOR and a PUMP The MOTOR is turned |
" 1 on immediately after pressing START and turned off after pressing STOP
; ' or when ALARM appears. The PUMP is turned on 3 seconds after

- 1 the MOTOR and turned off 10 seconds after it

» Main part of this instruction describes how to create and simulate such program. Other exam-
ples are presented later.



New program

Project

» New project is defined by selecting File 2 New in CPDev main menu or clicking New icon in the
toolbar.

I} CPDev

| File | Edit View Project Tools Window Help
(L] New Ctri+N Q - | B by by E e

5 Open Ctrl+0 |

» Enter Project name, here Start_Stop_LD, and eventually other data in Project properties win-
dow.

Project properties — O X
Basic  Advanced
General
Project name ‘S‘Lart_Stap_LD
Rile location \
VM specification: ‘C"'\ngram Files (x86)\CPDevFBD-1.1.4.15d\VM\VM-Praxis xml
Information
[ Subject: | Program tums motor and pump on and off
[] Version .v1
] Author :Jar'l Nowak
[ Company If.izeszaw University of Technalogy|
[ Created: {Tuesday February 06. 2018 9:58:58 AM
Conpied [Mondey. arar 07, 0001 720000 AM
Auto number: o
Cancel
» File location, compilation date and number will be filled in auto- 3 CPDev
matically while saving the project.
VM specification indicates path to virtual machine description file Bt Wew Propexct
file. DE-H g G
» Left part of CPDev window presents initial tree of the B Stat_Stop_LD -
Start_Stop_LD project. i POU
L-{Z7 Global variables
{5y Tasks
[ Libranes

Program name and language

* Program can be added to the project in two ways:
- from project tree:
o select project name, i.e. Start_Stop_LD
o from context menu, select Add Item = Program or select POU and from its context menu
choose Add > Program
— from CPDev main menu:
o select Project
o from drop-down menu, select ltem > Add and select Program in Adding new element
window.



Source language: | LD ~
Editor:  LDEditor ~
Cancel
» Project tree involves now START_STOP program. [@ Start_Stop_LD
Remark. For consistency with other editors, one can also e ?%T ART STOP
select function or function block as object type. However, poas S
editor window will not open (with notification at the T Global variables
bottom message list). Functions and function blocks can . Tasks
be created in ST and FBD languages (function blocks | i Libranes
also in SFC).
LD graphic editor
Tree
» Left part of LD editor window contains tree whose elements can be dragged or selected and
dropped on the drawing board on the right, between vertical lines (power rails).
» The right line moves automatically if element is moved too close or placed beyond it.

Enter Object name, here START_STOP, and choose LD language (default LDEditor appears).

Grey line farther to the right (move scrollbar or maximize) is the limit of first printed page. Grey

8! Creating new POU — [J

X

Object type:

Program o

Object name: |START_STOP

lines partition total work area into a few pages (see Printing).

By Start_Stop_LD.START_STOP =: program (LD)

-y Baswc elements
k-~ F contact
-+ Negated contact
L} Co
@ Constant
= input varabis
D Output vanable
bl Comment
=y Frequently used
47 ToN
=
~I1 A_TRIG
ﬂ RS
Lo dTx MOVE
*) EQ
y IEC_E11
4y IEC_61131(withEN)
?__; Functions (with EN)

- System biocks (with EN)

B{y Basic_blocks {with EN)

hd




* The tree involves:

- basic elements, such as contact, coil, input/output variable, etc.
- afew frequently used blocks and functions

— blocks of /IEC_61131 library in standard form (without EN)

- blocks of the same library, but with additional ENable input (with EN)
- functions, system blocks, and blocks of Basic_blocks library, also with EN.

Ly IEC_81131 =]-{F Functions {with EN) =-{f Basic_blocks (with EN)
{F co #-{& ADD, SUB, {T Amem
% cu +-{& AND, OR, T Aswi
{7 cruo +-{£ INT_TO_REAL, {T emem
{7 r.tRiG i-{ Ass, SOAT, {7 eswi
{7 =_RIG {5 GT,LE, NE, {7 come
{% ms +-{ ROL, SHR, { oesa
{7 sema +-{& SEL LMIT, {7 o=s
{T sr #-{& RTC. CYCLE, {7 orr
{% Tor 1-{£ HOUR, DAY, {7 oirr
ﬂ TON +-{C ROUND, TRUNC, ﬂ DIVI
% {7 NV _PAR B, {1 Fur

+-{5 Unciassified ﬂ GENR

Elements with EN

» Contrary to standard blocks of IEC_61131 library, all functions and blocks with EN are executed
only when TRUE appears at EN input. Such elements allow to implement in LD language some
simple diagrams typical for FBD.

» Functions branch consists of subbranches, such as arithmetic ADD, SUB, ..., logic AND, OR,
..., conversions INT_TO_REAL, ..., etc.

» Basic_blocks library involves special arithmetic blocks, switches, memory blocks, comparator,
flip-flops, pulsers, filters, and some nonlinearities (see basic CPDev instruction).

» Hardware dependent System blocks such as NV_PAR_... store parameters in nonvolatile
memory (BOOL, INT, REAL, TIME). aPON and aSTR raise alarms, i.e. alarm power-on (“warm”
restart) and alarm start (“cold”).

Find element

» Expanding the tree to find rarely used function or function [XoR & &
block could be cumbersome. To make it easier, user can [~ " o o ]
simply write a part of name in the text box above the tree to -{[%y Frequently used
trigger automatic filtering of elements. ¥ 1EC_81131

« Function subbranches and/or libraries with elements includ- 1y : LEC-:‘r*“t‘:i“

ing the written text are presented. For example, after typing -
XOR corresponding gate appears in the tree. Another text i ) XOR
may result in a few elements. System blocks (with EN)

Basic_blocks (with EN)

0e

Connections without or with EN

 First input and first output of a block without EN (from /EC_61131 library) must be connected to
other rung elements, such as contact, coil or another such block.

» EN input of a block or function with EN can be connected to:
— left power rail
— rung-like circuit involving contacts or blocks without EN.

4



Other inputs of blocks or functions without or with EN must be connected directly to input vari-

ables or constants (not to contacts, branch points or outputs of other blocks).

Other outputs of blocks without EN (other than the first one) must be connected directly to out-

put variables (not to coils, branch points or inputs of other blocks) or left unconnected.

Outputs of blocks or functions with EN must be connected directly to output variables or, ex-

cept the first one, left unconnected.

Editor options
| LD editor | Project Tools Window Help
& Verify by 222
| View 4 | #HE  Show lines

Advanced mode Show grid

Scale » 200%
Show/hide elements tree F2 % o

Show ST code of diagram F3
[¥] 100%
Use last selected element from tree F4 ]

+ | Automatic connections

Create connections
1

Manual

» The following options are available in LD editor menu:

Verify — checks diagram completeness (elements, connections, etc.)

View — contains options of diagram presentation:

o Show lines — switches on/off supplementary lines on the diagram

o Show grid — switches on/off grid and grey lines on the diagram

o Scale — chooses scale ratio

Advanced mode — switches on/off advanced mode, where some extra functions and blocks
are available (and visible in the tree)

Show/hide elements tree F2

Show ST code of diagram F3 (after Build)

Use last selected element from tree F4

Automatic connections — while placing elements on the diagram, automatically creates con-
nections between inputs and outputs at the same level and with power lines

Create connections — if clicked, supplements missing connections between inputs and out-
puts at the same level or with power lines (if needed).

Remark. Automatic connections option speeds up creation of straight rungs, involving con-
tacts, coils and blocks without EN (from /[EC_61131 library). Create connections typically
connects remaining inputs and outputs of blocks and functions. Besides the two options
one can always connect the elements manually.

Development steps

It is recommended to create LD diagram successively rung-after-rung, with verification of connec-
tions after each rung. Verification is also executed automatically every 10 minutes (if change de-
tected, see Automatic save in Other issues).



Global variables Start_Stop_LD

-1-{&z POU
» Global variables are usually declared at the beginning of P START_STOP
creating the project (see basic CPDev instruction). e e
» Declared global variables shown in the project tree are - STOP
included into hint list of the editor. = ﬁg’%};
» The list appears in Variable properties window (see below). : : PUMP
+-4 g Tasks
+|-y Librares
Rung

Place contacts, coils, blocks, etc. on the drawing board. If Automatic connections option is ena-
bled, connections between elements and power lines are created automatically giving a set of
straight rungs. Temporary names are provided automatically.

To transform straight rung into parallel branch of another main rung, remove connection to the
right line, add branch point in the main and connect last element of the parallel branch with the
branch point.

Change temporary names of:

— contacts and coils into names of global variables and target names of local variables

— input and output variables as above

— function block instances into target names.

Write in values and types of constants. Make sure that types of input/output variables are con-
sistent. Take printing into account.

Verify connections of the rung (editor option).

Remark. Contacts and coils of P, N, R, S type can be chosen while changing names (see
below).

Task. Compilation. Simulation

Declare task, select cycle and assign program (programs) to the task.

During compilation the open diagram is verified again and the whole project translated into ST
language. If the ST translation does not have errors, it is compiled into VMASM code of virtual
machine.

Online operating mode and CPSim simulator provide tracing of variable values during execu-
tion.

First rung of START-STOP

Two straight rungs (initially)

Place an element on the diagram:
— select the element in the tree on the left
- drag it to the target location (or select and drop)



Automatic connections enabled

By

{7 Basicelaments

AF Contsct s 8w npdtl

|

1 Negated contact

0 co ez
- place successive elements.

 inputt - -
e

~inputa’ - - -

* Remove connection of the lower rung to the right line:

— select the connection (becomes red)

- press Delete.

Branch point and manual connection

ik

= = =2
B ~
'il'IIJU13-‘-:-:-‘-:“OL-H:.)I.I-H-:
e N/
--------- .QL-JtDI.I-H.
......... I
......... LY
.“-m|:.-ut'1 ------ |r-wp.ul-2 hy

» Right—click at suitable place in the upper rung to add branch point ;:;: : ‘ :+. : : : ‘ l{ ‘:;

with two tips.

» Connections can be drawn from input to output or from output to input. |- 7. .o TTiii i

» Create connection manually:

— select or point at the input or output, which will be the beginning of the connection (tip color

changes to red)

— press left mouse button and drag cursor to the output or input which will be the end of the
connection (while moving the cursor dashed line from the beginning is drawn)
- release left mouse button what creates the connection with path calculated and drawn au-

tomatically.

-‘_inpuﬂ_------_mputZ -‘:input3----------

S nputa <l Ll

Contacts and coils as variables

H A

» Variable properties window allows to change name of variable associated with contact or coil
from temporary name such as inputi or outputi. To open the window, double-click the ele-
ment or select it and choose Properties option from context menu.



» If the project has been rebuilt after declaration of global variables, pressing the ellipsis button
(...) or F2 opens the new Global variable selection window where the user can choose the vari-
able without typing. The choice is confirmed by pressing Enter, Escape or closing the window.

inputt - - - - - inputz - - input3 - - - - inputt -+ - .- .- input2 - - input3 . - -
i o R o) o 2 AR M _ SR

_‘I variEkle it I... A F ‘I l .., Global variable selection n i
e ' ORI T (5000 =i '
JOPY e [t | NP me:| STOP (BOOL)
_{ re ! —{ ALARM (BOOL)
©! Type: |BOOL j .. Type: | MOTOR (BOOL)

.. Version: Local variable f 27 el | MERO0L)

. @4 F O4A4 Ol O I RO F |

START ----:: input2 - - input3 - - .- .- ST coece inputd cooecns s cee oo putput], -
: SRR Ok A R L R I AR
__| Py e dere et i 'L/Variable input2 properties n
inp '- A
_| sy svar =] - | Name: |[ST

. Type: BOOL | © 1 Type: START

o f ! Versior: | STOP

.. . Version: Global variable ; g Version:

@4k O+ Ok O4- = 1 OHLTE PFOR

» Variable properties window also provides nhame prompting functionality as an alternative to the
ellipsis button or F2. This may be convenient for long global variable list.
» Variables with names other than in the global variable list automatically become local.

Remark. CPDev compiler does not distinguish lower-case and upper-case characters. So
for instance name1 and NAME1 denote the same variable.

» Variable properties window also allows to change type of contact or coil into standard, negated

orP,N,R,S.
PR sl m e m e o e i
PSP —— "t i

Name: |outputl | e .
e Type: BOOL Global variable selection n
++ Version: Local variable START (BOOL)
;A STOP (BOOL)
- @) O O~ O—R)|ALARM BOOL)
i MOTOR (BOOL)
O-fr- O PUMP (BOOL)

» To close Variable properties window, press Enter, Escape or closing button.
First rung is now ready.

START 'STOP - ALARM - - - - - - MOTOR
| L : A N
1 T —— 1

. MOTOR - - [-- -

—




Verification

Choose Verify option from the editor menu. It checks completeness of the diagram (connec-
tions) and consistency of types of inputs and outputs. Results are reported at the bottom of
CPDev window.

LD editor |
|! <  Verify ‘l

) Diagram verfication started.
\i) Diagram verffication finished (emors: 0, wamings: 0).

If LD-to-ST translation of the verified diagram is of interest, press F3 (see below).
Open diagram is automatically saved every 10 minutes into temporary directory followed by
verification (see Automatic save).

Editing

Selection:

— select an element (becomes grey); successive elements are selected with Ctrl key pressed

— alternatively, press left mouse button at any empty place on the diagram and surround the
elements.

Moving:

— with element/elements selected, press and hold left mouse button while moving the cursor to
new location

— release the button.

Remarks. Element cannot be moved into new place if there is not enough room. It is shown
in red and returns to previous place after releasing the button.

Moving an element (or elements) updates connections automatically calculating relevant
paths anew. They may be somewhat different than before.

Removing:

— press Delete after selecting element/elements

— individual elements can also be removed by right-click, selecting Delete in the window and
left-click.

Copy and paste:

— select element/elements or a rung

— copy (Ctrl+C)

— move cursor to new location

— paste (Ctrl+V).

Remark. Before copying a rung it is recommended to enable Automatic connections, as it
supplements connections to power lines.

Automatic connections disabled

With Automatic connections option disabled the elements placed on the drawing board are ini-
tially separated (keep horizontal alignment).



: \ﬁpuﬁ '

o 'lnu'utzl o

AR TR

Second rung of START STOP

Elements and connections

- inputt
. "

_iﬁpufa_ :

ton1

. |r.1p.ut.1 .

TON

. G_”.

tof1

PT ET| -

.inp.uﬁ
. R

TOF

- —PT

ET

Connections may be created manually as above or by clicking Create connections and making
suitable corrections.

Blocks from the standard /EC_61131 library, such as TON and TOF, are placed in the rung in
the same way as contacts or coils (Automatic connections enabled). Temporary instance name
appears above the block.

- output! - -

A constant placed on the diagram is automatically connected to block input at the same level. If
there is no such input, it is left unconnected.

.DI;IIDU.H. -
T EEE

10

R

Remaining connections are created manually as before (select input or output, drag cursor to
another end with left button pressed, release the button).

- output! - -
Lot

mY

Connections between undefined or inconsistent types are shown in red.



Instance names

» Double-click the block to change temporary T T -
DELAY_ON - - - - DELAY_OFF

name |n'Bloc.k properties W|ndow. ' ) 3 oR ' e e e
+ Block width is updated automatically every time _ |, oI al—— "1}
when length of the name is changed. —PT TR properkibs B

T Name: |DELAY_OFF | §
__ Type: |TOH | ;

Constants
+ Double-click the em | (Toms——— M
Pty rectangle (rounged) .'[O @Cons’[ant properties ﬂ
enter value and type in Constant properties win- _—
dow. Type may be prompted automatically accord- - - . . Vaue: [Ta#5| IF

ing to value. ... Type: |TIME v]
« Second rung assumes the final form. I -

S -~ DELAY_ON - DELAY_OFF - e
MOTOR TON TOF PUNP

~H b a—w  a——{
-

» For information, type of each input/output of any element is shown in

tooltip after indicating the element’s tip. Q
ET

Comments

» After adding a comment to the diagram, double-click the empty rectangle. The window, where
content can be defined, is presented.

{ The program turns on /oif a MOTOR and a PUMP. The MOTOR is turned |
i.on immediately !
. . . . Comment properties n

"""" ** ' Comment contert

,,,,,,, © © 7 |The program tums on / off a MOTOR and
............ a PUMP. The MOTOR is tumed S s an S
""" ++ -+« |onimmediately | R

Verification

» Verify the diagram using the editor option. Press F3, if ST translation is of interest.

Automatic connections disabled

» The elements, initially separated, are connected manually as before. Alternatively, one may
click Create connections to supplement missing connections of inputs to outputs at the same
level or to power lines (if needed).

11



Task and compilation

Task

» Task can be added to the project in two ways:
— from project tree by Tasks = Add task or by Start_Stop_LD (project name) > Add item >
Task
— from CPDev main menu by Project > ltem > Add > Task (in Adding new element window).
» Enter Task name, here TASK_LD, choose Cycle interval and Executed programs from Available
ones.

Task properties — [} > l.

Task name ‘TAS K_LD |

Task type (@) Cyclic (O) As soon as possible
Cycle interval: iSD ~ Time unit: |ms
i
Executed programs: Available programs: 1

START STOP I START STOP |

Compilation — Build

» By clicking Build icon in the toolbar or selecting Project 2 Build in the menu
the whole project is first translated into ST language and then compiled into
VMASM code for virtual machine. If errors occur, compilation is stopped.
Warnings are reported, however the program can still be compiled. The pro-
ject may be eventually saved before compilation (Environment options >
Editing).

» Verification runs automatically before compilation provided that editor window is open.

\_i) Diagram verffication started

\i,) Diagram verification finished (emors: 0, wamings: 0).

(@) Building the tem “Start_Stop_LD". Started at 09:27:22
(&) Compiliation of "Start_Stop_LD" completed at 09:27:22.
(3D Linking "Start_Stop_LD" completed at 09:27:22.
:%)Statistucs: Emors: 0, Wamings: 0. Hints: 0

Remark. Program may be compiled even without task definition, however a warning
will appear.

» ST code of the translated diagram may be shown by pressing F3 (click the diagram first). It is
split into parts corresponding to rungs.

12



001 PROGRAM Start_Stop

ooz

003 VAR_EXTERNAL

oo4 START: BOOL:

oas STCP: BOOL;

ooe ALARM: BOOL;

o007 MOTOR: BOOL:

oog PUMP: BOOL:

0os END VAR

010 -

011 VAR

o1z out_contact START_90_100 i
013 out_contact_STCP_Z00_100
014 out_contact ALARM 270 100 N
015 out_contact MOTOR_S0_150 [l
0le
017
ol1s
o0ls
0zo DELAY OFF: TOE;

021 out_DELAY OFF Q [EE

022 END VAR

0zZ3

024 out_contact_ START 90_100 := START;
0256 out_contact MOTOR 90 150 := MOTOR:
02€ out_bp 110 90 := out contact START S0 100 OR out_contact MOTOR 90 150;
027 out_contact_STOP_200_ 100 := out_bp 110 90 AND NOT STOE:

028 out_contact ALARM 270 100 := out_contact_STOP_200_100 AND NOT ALARM;:
025 MOTOR := out_contact ALARM 270 100;

0z0

031 out_contact_MOTOR 70_Z10 := MOTOR;

032 DELAY ON(IN:=out contact MOTOR_ 70 Z210,PT:=T#5s,Q=>out DELAY ON Q):

033 DELAY OFF (IN:=out DELAY ON Q,PT:=T »Q=>out_DELAY OFF C):

034 PUMP := out_DELAY OFF Q:

03s

03€ END_PROGRAM

: BOOL;
: BOOL;
: BOOL;
: BOOL;
: BOOL:

» Local variables with (*$HIDDENONLINE*) directives created automatically do not appear on
variable value list in online mode.

Online mode

Tracing execution of a project is provided by CPDev online mode. The project may consist of a
number of programs written in the same or different languages. Tracing is particularly convenient
for graphic languages, such as LD.

Go online
Before going into online mode, the project must be built (rebuilt after changes).

» Click Go online icon in the toolbar (becomes framed) or select Pro- o [fa
ject 2 Go online in the menu. -

+ The icon indicates that Data sources are set to Simulation. PIOGRM Go online (Simulation) |

III T —————ra————

LD diagram online

» CPDev window in online mode involves “live” LD diagram and list of variable values on the left.
BOOL values are distinguished by continuous (TRUE) or dotted (FALSE) connections. Values
of other types are written above connections, except connections to constants.

13



J CPDev - O X

File Edit View LDeditor Project Tools Window Help

NDEH &8 CORLeY v | B g g & ﬁ Global Search & -
START_STOP

— B Start_Stop_LD.START_STOP : program (LD] [online] (= [E ]

Start_Stop_LD.START_STOP . A L X X B, o T N
Varizble Value _—m i o e e
| | E-{&F Basicelements ]

START FALSE I

STOP FALSE | W Negated contsot

ALARM mse| || | P

| | -@ Constant
MOTOR FALSE O Input varabie
| pumP FALSE | {3 Output variable
1 {hee Comment

DELAY_ON [IEC 611 | I & G Froquentsyuse

N FALSE + - Ton
| | I Tor

PT 5000
I ! Sramee 00 | G EET we i SDG S0 BT U R R ORI Eh mE OO R RE RN ORI B R B 0 R R

o FALSE | ftas

DELAY_OFF IEC_611.. | i Move el s REEEREE
| . [ eaise | ) E0 DRTE R A R b gy (OELACON v g gy JDRLRLORE _ sor i B EE 10
e | FASE| W & G Ec st - .. MOTOR [ Ton . . TOF : " 'PUMP

T 10000 @55 1EC_81131 (with EN) — Ll SRR Y1 Q;A,j,‘,;,ﬂ,,{ );,;,'A Ny
[a | Fasel -5 Functons (with EN) BT ETl
. {5y System biocks (with EN) .
{5 Basic_biocks {with EN)
. The program turns on /offa MOTOR and a PUMP. The MOTOR is furmed
- * | on immediately after pressing START and turned off affer pressing STOP | © * * ="' ' *
. . {orwhen ALARM appears. The PUMP is turned on 5 seconds after
- | the MOTOR and turned off 10 seconds after it
......... Y
< >

POU  Rescuces Types Online

Value may also be shown in tooltip after indicating a connection or tip of element. Type appears
as well if tip is indicated (TIME in milliseconds).

3 {’\LARM_ T FT

= TIME

srt | BOOL 200

FALSE}. -~~~ """~
Change value:
— select input (contact, variable) START .. ... SToP .. ALA
— double-click e el
— enter new value, accept or close the window. F'm-m etyalle
Change is reflected on the value list. R |

TRUE, FALSE may be entered as 1,0.
Constants cannot be changed in online mode.

If a few diagrams are open, the one on the top is “live”. It is indicated by [online] after name of
the program.
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Value list

List with values involves variables associated with “live” diagram, so
global and local variables, and function blocks with inputs/outputs. If
no program is open, global variables are shown only.

Change value: Variable Value
— click current value (becomes blue) START [ TRUE
— enter new value, accept. '

Icons above the list provide: a
— start simulation again (if stopped before)

— stop simulation temporarily (still in online mode)

— show/hide global variables

— show/hide inputs/outputs of function blocks.
Stop freezes current values and LD diagram. Start resumes
online operation.

The open list is associated with ap- POU | Rescuces | Twes | Oviiio
pearing Online tab at the bottom.

Clicking POU tab on the left opens project tree, for instance to
choose another program for tracing. Then click Online again.

Data sources

Clicking Data sources icon shows data sources for online mode,
beginning with Simulation. Other sources, if shown, represent spe-
cific controllers for which online mode means commissioning. They
may involve WinController, an advanced CPDev runtime for Win-
dows.

3w 2 |[6l0
Start_Stop_L D START_STOP

Vanable Value
START FALSE
STOP | FALSE
ALARM FALSE
MOTOR | FaLSE
PUMP | FALSE
DELAY_ON '

IN | FALSE
PT | 5000
a FALSE
DELAY_OFF '

IN | FALsE
PT | 10000
a | FALSE

POU  Resources Types Online

CPDev - WinController |

Flash (emulated): [0

Data sources X ‘ s Simulator properties 3¢
Select cumrent data source: J Resources  Statistics Options  About
Vitual machine address size bits): 16
Simulation v Properties Memory usage (bytes)
Simulation

Code: [506 | Data: [0

Some data of simulated project are shown in Simulator properties window.

CPSim simulator

Another way of tracing variable values during execution is provided by CPSim simulator. It is more
flexible than online mode allowing to assign most important variables to panels with buttons and
“LEDs”, as well as to individual views or custom lists.

CPSim is run by clicking Run simulator icon in the toolbar or by
selecting Project 2 Run simulator (also Tools = Simulator).

15
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Global variables

» CPSim window presents initially the list of global variables. Execution begins by clicking Start
trace icon or by choosing Trace 2 Start.

P4 CPSim :: Simulation - Start_Stop.dcp == O >

File Trace View Datasource Tools Window Help

= j J“ == » o n 1 | 352 Simulation

=& Start_Stop

= e Global variables Globa! variables n
== START Variable Value
- STOP I
—= ALARM START | 1
A sror
: PUMP
: =y ALARM 0
@B Task TASK_LD |
MOTOR | 1
PUMP | 1

S 00:00:19

» Values of those global variables which are inputs to the program can be changed. More on
CPSim can be found in Help > Programming instruction.

Remark. Values of boolean variables are displayed as 0 (FALSE) and 1 (TRUE).

Control panel

» More convenient way of testing is provided by selecting Group panel icon or relevant option in
View.

Name: [START STOP | I

Panel type
(®) Control elements () Variable list

After creating the panel dag and drop on it |

variables from the varable tree

» Type name in Panel properties window, accept and drag required variables from simulation tree
on the left into the rectangle panel (which grows accordingly).

START STOP B

B (o] [ ]

» Test the program by pressing input buttons (BOOL) or by typing values in input cells (also other
types).

Individual view

+ Single variable can be traced by dragging it from the tree into DELAY ON.PT a
view area. Individual views are used for important local varia- _
bles and inputs/outputs of function blocks (PT here). Value: 5000 ms|
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Variable list

» By choosing Variable list in Panel properties window a list of variables dragged from the tree
can be created. Inputs/outputs of function blocks or local variables used in the diagram (if any)
are usually assigned to such list (which looks the same as the list of global variables).

¥# CPSim : Simulation - Start_Stop.dcp bt () >
File Trace View Datasource Tools Window Help
== I e W aa 222 Simulation
=i Start_Stop
—| mrm Global vaniables
— gl;zlr Variable Value
S0 -
e ALARM HALSE
~um MOTOR STOP TRUE
o PUMP ALARM FALSE
B Task TASK_LD
S- b Program START_STC| | | MOTOR FALSE
=T DELAY_ON PUMP TRUE
N
i i[! PT
05 a START STOP [« |
. & ET
=T DELAY_OFF
o [sroe ] [poe]
@ PT
O5q
Oy eT
Value: | 5000 ms| Value: 2235 ms
< > | ¥ ¥
I 00:01:03

Sessions

» Lists, panels and views created for simulations can be saved for future use by selecting Trace
- Save session or by Yes answer to the question Do you want to save the trace session?
asked on CPSim exit. Session data are saved in the project folder as SCP file.

» Complex project may require a few simulation sessions with different views. Data of each ses-
sion should be saved in separate file and run by Trace > Open session...

Elements with EN

Rung conditions

» Rung may involve only one element with EN, i.e. block or function dragged from the editor tree.
» Connection rules are given in Connections without or with EN (earlier).

Functions

* Number of inputs of some functions can be selected
as follows:

— open Function properties window (double-click)
- choose suitable number of inputs (2 + 15).

* Number of inputs can also be incremented or decre-
mented by selecting the function on the diagram and
pressing ] or [ bracket key (+1 or -1).

» Alternative type of variable can be selected from the
list opened by clicking default entry.

17




Input/output negation

» Right-click particular input or output of function or function block to dAND L
negate it (boolean signals only). EN input can be negated as well. - :

Manual connections

» Manual connections are preferred for a rung involving element with EN because inputs and out-
puts of such element, except EN, must be connected directly to other inputs, outputs or con-
stants (not to contacts, coils or power lines). Hence Automatic connections option of the editor
should be disabled.

START STOP with EN

 Comments:
— local variables loc1, loc2 transfer data

.- [STARTSTOP-WthEN | - - - - - - - - - -

between the rungs L UUSTART - et
— function and blocks with EN occupy one  |——| }T ()

rung each s bk bl gl e sl e s ok el ER o ol w
- except EN, inputs of the function and | "~ T i

blocks must be connected to variables
or constants (not to contacts) = |—— — D ik s B S S B2 s
- output of the function and first outputs of | .. .. %1 ] anp [ [MOTOR | - - - -

the blocks must be connected to varia- |- - - S22 " R

) -+ | ALARM ——(
bles; other outputs may remain uncon- ; S me e U S W o
nected G2 v I s 3 DEERON g v on v gt
- temporary variable names are changed |- - - e T
in Variable properties window (double- e P e we B

click) - [MOTOR |——IN af—loc2 |-
.- [T#5s PT 3 I

— Create connections option is preferred, i B 2
with some manual corrections. PR AR WO ETER o

....DEL_A'\,’_OFF....
UEE VI 1 B BT me T T BT B 5 2
® ot o e el o TE FITT
T (T i ol e ]
- [t#10s }——P1 BT -ocveeeees

Other issues

Changing LD program name
Program name given initially needs to be changed sometimes in the final version.

» To change program name:
— open the diagram (if closed)
— select the program in the project tree
— choose Project > Items > Rename
— enter new name in the tree
— accept (Enter)
— build and save the project.
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Library warnings

When library is linked to a project, CPDev automatically stores library version, timestamp and
number of compiler version which created the library (LCP file). When the project is open again
and built, those markers are compared with markers of actual library and compiler. Inconsistencies
trigger warnings.

The following warning indicates outdated library:

{8\ Declared lbrary timestamp ~ date  is not equal to timestamp found in lbrary name  fromfile 'C; location

If library content and compiler version have not been changed, ignore the warning and proceed

with the project. Warning will not appear on next opening.

Otherwise:

— remove the library from the project tree by selecting the library and choosing Remove from
context menu

— import actual library into the project by Project > Import - Library from appropriate file.

New version of CPDev compiler includes recompiled system libraries, i.e. IEC_61131.Icp and
Basic_blocks.lcp. So only user library, if any, needs recompilation, export as LCP file into given
location (Project > Export - Library) and import into the project as above.

Automatic save

Every 10 minutes (default) CPDev creates a file in temporary directory (see operating system
settings) called CPDev_ProjectNameOQOrFileName _EightHexNumbers.xml with source code of
the project. This is a back-up in case of CPDev crash.

If LD diagram has been changed within that period, it is automatically verified (if open).
Automatic save period may be changed in Environment options = Editing.

Standard examples

Protection against frequent restarts 1; R NS ARG RERTTAL 1

After STOP or ALARM (thermic sensor) another restart o R PN O 0 W
possible only after 10 seconds. Endeadas Yo
CPSim: control panel and individual view of ET output T IR ) 1
(elapsed time).

Restart protection E3

/alue:
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Start-up horn

» START turns HORN on for time set by H_TIME
(10s). Then CONVEYOR begins to move.
» CPSim: control panel while HORN is on.

Start-up horn

= B (o) | ®e
ET

Blinking light

e LIGHT blinks when IN is on. The two timers im-
plement a pulse generator (oscillator) operating

continuously.

» CPSim: IN and LIGHT at different steps.

Blinking light

Blinking light [

Blinking light

H =

Two heaters

» Equipment set-up

—

> T O

Sensors A, B, C

PLC

— H1

— H2

0 — temperature below the level
1 — temperature above or at the level

Heaters H1, H2

0-off,1—on

20
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. VtDrVWOV . - VSET up . . HORN . - .
| ] N - I N - N
_ T — 1T e W S—
HORN: . Vs‘et' up Vl(éC‘)I\;V‘E"‘/C‘)R: c

| P
r 11 1
TON1Q -
Fa T
LA
ton2 ::;:;:::
TON1Q - - - | TON Tofwﬁu-
oM | ,
— — N Q- A
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SN DI ToNTQ LIGHT - - -
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Control task (temperature)

t <A H1 H2 - both heaters on
A St < B |:> H1 -
B <t<C - H2
C st - -
Sensors OK

CBA — 000, 001,011,111 — S_OK = AB+ BC

Solution (e.g. Karnaugh):
H1=B3_OK,, H2=(A+BC)[$_OK

CPSim: control panel and individual view of S_OK.

Two heaters x| l.TWO_HEATERS_DT.S_OK x|
Value: 1|
[2] (]
Examples with EN
Single pushbutton
Second and third diagram, not the first one, in- Ll [SGLEPUSBUToNT 1
clude elements with EN. 3 571 51 35 €92 19 5 3 T 5 B 61 1 0
« First pressing ON_OFF turns MOTOR on and : i:r_ﬂOFF et ORE:JLZZW
another turns it off. ek a
* Implementations:
- standard Eliprs i heroR
— XOR gate instead of contacts rriiarionitie
- TFF flip-flop from Basic_blocks library. — 1

mE—fr ol —fwwR]
ON_OFF ———|CLK S
......... ..‘ .. FALSE R .
Coerer [
e CPSim: ON_OFF input and MOTOR at different steps.
Single pushbutton Bl Single pushbutton [ x | Single pushbutton [ x | Single pushbutton B

] [ o]

.
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Low/High alarms

AL_H or AL_L arise when IN_R (REAL)
violates LEVEL H (90%) or LEVEL H
(10%) alarm level. COMParators are set
with 1% hysteresis (Basic_blocks).

CPSim: alarms for IN set to 20% or 91%.

Low / High Alarms [ x |

INR
Low / High Alarms [ = |
(o1

INR

Sequential controls

Greenhouse

PLC keeps temperature in a greenhouse between low
A and high C, preferably near middle B. If the tempera-
ture drops below A, heater HEAT is turned on. It is
turned off when the temperature reaches B. Fan COOL
is turned on when the temperature exceeds C and
turned off when it drops below B.

State diagram

HEAT OK c COOL

Implementation involves R, S coils. Rungs cor-
respond to transitions in the state diagram.
CPSim: HEAT and OK states.

Greenhouse n

W (][] I (] [eo

Greenhouse n

BN H=

22

S [LOW/HIGHALARMSY -
.......... cump 1 .. I P
.......... COMP e s s oa s s
EN  |-oeaiiiinn
-~ [nCr IN1 Q AL_H] - -
LEVELH ——in2 S .
S L e L
comp_2
comp
EN |
LEVEL_L——IN1 al—JaL L] -
—Tinr N2 |
L H ..........

—> [pLc [ AT
— COOL

> O

G
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__________________ (s}
CLUOK A oK - - -
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Reverse switching

» If INis on then OUT1 is on and OUT2 is off, or conversely. OUT1 is on for time T1 (3s), OUT2
for T2 (2s). If IN is off, OUT1 and OUT2 are also off.

» State diagram

TON1 TON1Q TON2
IN
OUTH1 l OUTI=1 OUT1=0
— ‘— ; 0UT2=0 OUT2=1

T T2

OUT2§ ] ]_—[
ONONONONOIO

...... : i Cen 1Ll ToNig Clllilen il
______ :REVERSESW.‘TCHJNGS::___:::::: R | fR'\;' C
: S 1 paee— \RP——
S TON1 DY R oS3
Ss2 TON Tc'{mj\'o T I e (5>
| N @
T#3s PT ETf - - A © 83 oo ToN2a S
L — — p——(R ——
R RS E R SESEEEEEEENEEEEE N Y
Sl AONZ e DR BN 1S
SS N N TON TC}N2Q """ ' ""
I ..... IN Q ------------ 53 ..... |N ...... 53
. P R P L A .
'@f” ET—::::::::’f::::: | | L+ (R}
D S I I :fs'w\:f:
T \Sh—
S1 IN 51
| | P - s2 OUT1 -
| E— (I A7 | ()
L . o
.................... S g
""" S A |l F
________________________________ T LA
SRR TREREES 'VSZ\' _______________________ o
| —— L R
SRR ST AN
L T G a—
» CPSim: states S1, S2, S3 of the sequence.
Reverse switching x| Reverse switching u Reverse switching n

(=] I [=] [=]

ey BEY

| NENRENN
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More on connections

Parallel connections
|t - out1 =in1 AND (in2 AND in3 OR in4)
—
© liriimiiiiiiiiiiiiiiiiiioiiiioo — outl = (in1 OR in2) AND (in3 OR in4)
| S S
I N BRI out1
— —+—+ | —{ —
oo | L

~ out! = in1 AND (in2 OR in3) AND (in4 OR in5)

- in3 -

out! =in1 AND in2, out2 =in1

out1 =in1, out2 =in1 AND in2
out3 = in1 AND in2 AND in3

block surrounded by contacts inside rung
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Warnings for EN

» Warnings No contacts/coils exist may appear after verification of diagram involving rungs merely
with elements with EN. They indicate that connections are correct, although untypical for

standard LD diagrams.

ton_1

TON
T ——IN al——our1] - - -
o liN2 —PT eT——out2| - - -

Wrong connections

N2 - -out -

R [ e [ e O
'

N ERRRRRRRS ~

— AND | ——fourt | -

) outi - - - out2 - | ----- out1 - - - 2 -
JEREN A [
T NCERRRIREEEE
Printing

Size adjustment

input variable mixed with contact and coll

direct connection of input variable to output
variable (use MOVE instead)

second input of function (with EN) connected
to contact (input variable or constant re-
quired)

third input not connected directly to input var-
iable

output not connected directly to output varia-
ble

trivial errors

» Grey lines partition total work area of the editor into printed pages. Final size of the diagram
may be decided before printing to fill in the pages conveniently.

Remark. Diagrams presented above are fairly tight (for consistency). They may be wid-
ened taking into account the grey lines, as the START_STOP printout shown farther.



Page setup

» Choose Tools > Environment options = Configuration > Page setup.

| Projects Edtting Colors Miscellaneous Compiler Help

Border margins
Left {cm): D5
Top (cm) 0.5

Draw border

: Draw title block
I Title block fields
Subject
Project name
Filename

ar

Right (cm):

[==]
(%]
»

©
w

v Bottom (cm):

Padding (em): 0.3 =

Company
Project version POU name
Date

Update settings upon printing session

Page setup
Paper/Orientation Printing scale
Paper size: A4 ¥ User scale
@® Portrat User scale (%): 100
O Landscape
Author

Page number

4r

» Upper part of the options involves Border margins, Paper size, Orientation and Printing scale
(independent of the editor scale).
» Number of pages being printed is determined automatically according to the size of the diagram
and printing scale (user selected). Small diagrams need one page, large ones a few.
» Lower part specifies what fields appear in the title block (table) printed at the end of each page.
Table changes somewhat if some fields are not selected.

Subject: Program turns motor and pump on and off

‘Ej:-::mpjl‘y': Rzeszow University of Technology

Project: Start_Stop_LD

Version: V.1

POU- START_STOP Author Jan Nowak

File: C:\Users\Leszek Trybus\Documents\CPDev - programy, instrukcje\Projekty... |Date: 08.02.2018 11:20

|3:-,-;\e: 1/1

» Data for Subject, Company, Project, Version, Author and File are copied from Project properties
window. Active window determines POU name.

Remark. Options of Page setup are kept in CPDev database (Environment options), so

they apply to each printing till changed.

Print

» Choose File > Printin the main menu or press Ctrl+P keys or icon in the toolbar (direct print).
» Select printer and preferences in printer selection window. Change of preferences and printout
adjusts grey lines and Page setup options accordingly.

» Press Print.

Remark. Printing to virtual printer such as PDF Creator or Microsoft Print to PDF is conven-
ient way to verify expected printout. Vertical orientation (portrait) suits LD, SFC and horizon-
tal (landscape) FBD.
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START STOP ALARM ME()TCIH
| | [
— /1 11 { )
MOTOR
DELAY_OM DELAY_OFF
MOTOR TON TOF P'F'MP
| | N Q IN Q { }
(T#5s PT ETH FT ET[-
T#i0s }
{ The program tums on / off  MOTOR and & PUME. The MOTOR is tumed
| on immediately after pressing START and tumed off afier pressing STOR
| or when ALARM sppears. The PUMP is fumed on 5 seconds after !
L the MOTOR and fumed off 10 secondsafterdt. |
Program tums modar and pumg on and off Fzeszow Universily of Technaology
S Stop LD vl START_STOR sutres Jan Mowak
05022018 1120 | aga 111

Ceers Leszel TyUe DOcUmentsiCPDeY - Drogiamy, NsTUkGe Proekty. .

27



